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Disclaimer  
The information given on Diet & Exercise Assistant® is designed to help you make informed 
decisions about your health.  It is not intended as a substitute for or extension to the advice or 
treatment prescribed by your physician.  You are solely responsible for the way that this 
information is prescribed and utilized.  In no way will Keyoe, Inc. or the authors of this product 
be responsible for any problems that might occur due to the use of this product or the 
information contained within. 

 

Warning!   
Safe weight loss is considered to be no more than 1-2 pounds per week.  It is usually not 
considered safe to eat less than 1,200 calories per day, unless advised to do so by your 
physician.  Please consult your doctor before beginning any diet or exercise program. 
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Chapter 1 Installation 
This section describes the installation steps on a Microsoft Windows desktop computer.  If you purchased 
Diet & Exercise Assistant for Palm OS®, Pocket PC®, or Windows Mobile®, you must have the same 
version installed on the mobile device and on the desktop in order to synchronize data.  

Installation Steps for Windows Computer 

Follow these steps to download and install the product: 

1. When downloading software from the Internet, select Save rather than Open.  Specify a directory on 
your hard disk where you want the download to go, for example c:\diet.  After the download completes, 
you will have a single setup file. 

2. Double-click the download file to run the desktop setup application. 

3. Follow the dialogs to install Diet & Exercise Assistant Desktop. 

4. Remember to re-boot your PC to register the synchronization conduits. 

5. If you purchased Diet & Exercise Assistant for Palm OS®, Pocket PC®, or Windows Mobile®, follow the 
mobile device installation directions in the corresponding section.  
 

Installation Steps for Palm OS® 

Follow these steps to download and install the software: 

1. When downloading software from the Internet, select Save rather than Open.  Specify a directory on 
your hard disk where you want the download to go, for example c:\diet.  After download completes, you 
will have downloaded a single compressed file. 

Note:  This is a compressed file that requires an unzip utility to extract the contents to hard disk.  If you 
have Windows XP or Vista, you already have an unzip utility as part of the operating system.  

2. Using the Windows Explorer, browse to the file you downloaded in step 1.  Open the download file by 
double-clicking on the file.  Extract the contents of the compressed file to a directory on your hard disk, 
for example c:\diet.  If successful you should see the file DietExerciseAssistant.prc in the c:\diet 
directory. 

3. Install the file DietExerciseAssistant.prc to your Palm OS device by double-clicking on the file.  This 
will add the file to the “Palm Install” application.  Alternatively you can open the Install application from 
the Palm Desktop software and add the file by using the options in the dialog.  On Windows Vista 
double-clicking .prc files will fail with older Palm Desktop software.  To work around this, open the Install 
utility and add the .prc file by using the Add button. 

4. The Diet & Exercise Assistant software will install on the next HotSync® operation. 

5. If you purchased Diet & Exercise Assistant Desktop, double-click the download file to run the desktop 
setup program.  Follow the dialogs to complete the installation.  You must RE-BOOT YOUR PC to get 
the HotSync® conduit to self-register.  Diet & Exercise Assistant Desktop will automatically upgrade 
your data and copy it to your handheld device on the next HotSync® operation. 

Note:  The desktop version is sold separately and is required to upgrade your data. 
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Troubleshooting Palm OS® Installation 

Error Running the Setup Utility 
If you experience problems running the installation utility, try the following: 

1. Install to main handheld memory.  Memory cards are not supported.  If you install to a memory card, 
your food database will be empty. 

2. Make sure you do not try to load the compressed file DietExerciseSetup.zip directly to the handheld.  
Unzip the contents of the downloaded file to hard disk. 

3. If you do not select the correct handheld user name from the install dialog, the HotSync® Manager will 
not install the files to your handheld device. 

 
HotSync® Conduit Not Listed 
If you do not see the conduit “Diet”, do the following: 
 
1. Re-install the desktop application; remember to re-boot your computer in order to register the HotSync® 

conduit. 

2. Upgrade your HotSync® Manager from your handheld manufacturer.  After upgrading the HotSync® 
Manager, you will need to re-install the desktop application in order to register the HotSync® conduits. 

Installation Steps for Pocket PC and Windows Mobile® 

Follow these steps to download and install the software: 

1. When downloading software from the Internet, select Save rather than Open.  Specify a directory on 
your hard disk where you want the download to go, for example c:\diet.  After download completes, you 
will have downloaded a single compressed file. 

Note:  This is a compressed file that requires an unzip utility to extract the contents to hard disk.  If you 
have Windows XP or Vista, you already have an unzip utility as part of the operating system.  

2. Using the Windows Explorer, browse to the file you downloaded in step 1.  Open the download file by 
double-clicking on the file.  Extract the contents of the compressed file to a directory on your hard disk, 
for example c:\diet.  If successful you should see the file DietExerciseSetup.exe in the c:\diet directory. 

3. Run the downloaded setup file from hard disk.  Do not run the setup program from the unzip window; 
unzip and run from hard disk. 

4. The Diet & Exercise Assistant software will install on the next ActiveSync® connection. 

5. If you purchased Diet & Exercise Assistant Desktop, double-click the download file to run the desktop 
setup program.  Follow the dialogs to complete the installation.  You must RE-BOOT YOUR PC to get 
the HotSync® conduit to self-register.  Diet & Exercise Assistant Desktop will automatically upgrade 
your data and copy it to your handheld device on the next HotSync® operation. 

Note:  The desktop version is sold separately and is required to upgrade your data. 
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Troubleshooting Pocket PC and Windows Mobile® Installation 
The following are common questions and recommended solutions. 

Empty Food Database 
If your food database is empty, install to main handheld memory.  Memory cards are not supported.  
 
Losing Data after an ActiveSync® Operation 
If you lose data after an ActiveSync® operation, try the following: 

1. Make sure you synchronize with only one desktop computer.  Synchronization to multiple computers is 
not supported, and you will lose food and user data. 

2. Make sure the Diet & Exercise conduit is set to Synchronize. 
 
ActiveSync® Conduits Not Listed 
Right-click the ActiveSync® icon located at the bottom right of your desktop; select “Open Microsoft 
ActiveSync.” Click the options button; if Diet & Exercise is not listed, try the following: 
 
1. Re-install the product and re-boot your PC to register the conduits. 

2. Disconnect your handheld device to select the Diet & Exercise option. 
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Chapter 2 Technical Notes 
The following technical notes will help you to resolve any issue that might occur while using the software.   
HotSync® and ActiveSync® technical notes are only applicable if you purchased both the handheld and 
desktop software.  

Palm OS® Note:  Diet & Exercise Assistant synchronizes once per HotSync® connection.  To synchronize 
again, press the HotSync® button on the cradle. 

Pocket PC® Note:  Diet & Exercise Assistant synchronizes once per ActiveSync® connection.  To 
synchronize again, disconnect and reconnect your handheld device.   

Synchronization to Multiple Computers 
If you purchased the Windows desktop product, you can synchronize data between your handheld and 
desktop computer.  Make sure you synchronize with only one desktop computer with Diet & Exercise 
Assistant Desktop installed.  Synchronization to multiple computers is not supported, and you will lose food 
and user data. 

Synchronization with Desktop Open 
You must close the desktop application in order for the HotSync® conduits to synchronize your data.  If the 
desktop is open, the conduits cannot access the data files. 

HotSync® Conduit Installation 
In order to install the desktop HotSync® conduits, you must have HotSync® Manager V3.1.2 or later.  After 
installation, you must reboot your computer to register the conduits. 

HotSync® Conduit Settings 
Make sure the “System” or “Backup” conduit is set to “Handheld Overwrites Desktop.”  This is the default 
setting after installing the Palm Desktop software.  This setting requests the HotSync® Manager to back up 
all databases at the end of synchronization.  If the “System” conduit is set to “Desktop Overwrites 
Handheld,” you are requesting the HotSync® Manager to restore databases from backup, which will 
overwrite your data. 

After installing the desktop application, please make sure the conduit “Diet” is set to synchronize. 

Index Out of Range Error 
If you receive an “Index Out of Range” error when running the “Diet” application, your user or food database 
is corrupted.  Databases can be corrupted by pulling the handheld out of the cradle before the HotSync® 
operation completes, running the software when low on battery power, or running the software when low on 
memory. 

If you made a backup of your data files DEA-UserDB.pdb and DEA-FoodDB.pdb, you can install these two 
files to fix the problem.  If you do not have a backup of your data files, you will need to re-install the software. 
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ActiveSync® Technical Note:  Conduit Settings 
Use the following steps to set up the ActiveSync® conduit.  By default, the conduit will be disabled. 

1. Disconnect your handheld device. 
2. Right-click the ActiveSync® icon at the bottom right of your desktop. 
3. Select “Open Microsoft ActiveSync®.” 
4. Click the Options button. 
5. Select the Diet & Exercise conduit. 
6. Select OK. 
7. From the ActiveSync® dialog, right-click on the Diet & Exercise entry. 
8. Select the “Synchronize” option or select another option that better suits your requirements. 
9. Select OK. 

ActiveSync® Technical Note:  Desktop User Name 
On the first ActiveSync® operation, the desktop user is assigned to the handheld.  This cannot be changed.  
If you wish to assign the handheld to a different desktop user, select the user in the desktop application and 
set the ActiveSync® conduit to “Desktop Overwrites Handheld.”  The handheld will then be assigned to the 
new desktop user. 
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Chapter 3 Backing up Data 
There are two data files associated with Diet & Exercise Assistant Desktop: UserDB.ddb and FoodDB.ddb.  
Every time you save the software will backup your data files.  You can use the File->Import menu item to 
restore your data from backups. 

 

 

Chapter 4 Healthy Dieting 
A “diet” includes everything that is consumed.  A well-balanced diet is based on scientific principles to 
provide sound nutrition, adequate intake of nutrients, and to promote optimal health. 

Warning!  Safe weight loss is considered to be no more than 1-2 pounds per week.  It is usually not 
considered safe to eat less than 1,200 calories per day, unless advised to do so by your physician.  Please 
consult your doctor before beginning any diet or exercise program. 

Diet Plans 
Diet & Exercise Assistant has three standard diet plans: low calorie, low carbohydrate, and a low fat diet.  In 
addition to the three standard diet plans, you can configure Diet & Exercise Assistant to work in combination 
with any of the popular diet programs today: Atkins, South Beach, Shape Up, Zone, etc.   

For example, to set up Diet & Exercise Assistant to track an Atkins diet, you should select the low 
carbohydrate diet.  You should turn off automatic calculation of nutrient targets and manually specify the 
grams of carbohydrates you are allowed to have depending on the phase of your Atkins diet. 

Food Nutritional Information 
Values in the food database are based on publications issued by the U.S. Department of Agriculture (USDA) 
and on the data published by manufacturers and restaurants.  The U.S. Department of Agriculture issues 
basic tables on food composition for use in the United States.  The commercial products from USDA 
publications represent average values obtained on the products of more than one company.  Data on 
commercial products listed by brand name are based on values published by manufacturers for their own 
products.  Data on the food composition of items sold at restaurants was obtained from their respective Web 
sites or literature obtained from the restaurant. 

None of the companies listed in the food database have any association with this software product or 
endorse its contents. 
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Chapter 5 Using the Software 
 

 

Desktop Main Screen 
Familiarize yourself with the following areas on the main screen: 

1. The Food Database tree along the left allows you to drag and drop any food item into the Meal 
Logbook.  Use right-mouse menu items to manipulate the database any way you wish.  

2. The Calendar control on the upper right is used to navigate between days. 

3. Above the Calendar control, you select or set up a new user.  If you own a Palm OS handheld, select 
the name of the handheld to which you want to establish a HotSync® connection.  The desktop version 
supports multiple users, with or without handheld devices.  If you own a Pocket PC® handheld, the user 
name is assigned during the first ActiveSync® connection. 

4. On the right is a series of buttons that allow you to perform the following actions: 

 Enter your daily weight 
 Change your Basal Metabolic Rate (BMR) 
 Input exercise data 
 View your Food Budget and Nutrient Targets 
 Chart your weight 
 Use the histograms to chart nutrient intake vs. nutrient targets 
 Input blood pressure 
 Input body measurements and calculate percent body fat 

 

5. At the bottom is a series of tabs that allow you to perform the following actions: 

 Input your personal information, set weight loss goals, and select a diet plan 
 Summarize daily data and goals in the Logbook 
 Use the Meal Log to input food items you consume each day. 
 Make notes in the Daily Journal 
 Review your daily data for all days in the Summary Table 
 Quickly summarize each nutrient and compare it to the daily targets in the nutrient tables 
 Take a health quiz to learn about healthy eating and living. 
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Chapter 6 Entering Personal Information 
Be sure to enter all of the Personal Information required by Diet & Exercise Assistant.  Personal information 
is used to calculate BMR and plot your current and desired weight against normal values for your age, 
height, and gender. 

 

 

Chapter 7 Setting Weight Goals 
Diet & Exercise Assistant allows you to set weight goals. 

Be sure to enter your initial weight and the date you wish to begin tracking your diet.  Once you specify the 
starting information, set your target weight and the date you would like to reach your new weight.  Use the 
Calorie Calculator to determine the number of calories you will need to eliminate from your diet per day in 
order to reach your goal.  You can continue to set and reset your goals as needed. 

Warning!  Safe weight loss is considered to be no more than 1-2 pounds per week.  It is usually not 
considered safe to eat less than 1,200 calories per day unless advised to do so by your physician.  Please 
consult your doctor before beginning any diet or exercise program. 

 

 

Chapter 8 Selecting a Diet Plan 
Diet & Exercise Assistant has three standard diet plans: low calorie, low carbohydrate, and low fat.  Select 
one of the standard diet plans or input your own plan.   

To specify nutrient targets, select a diet plan or input your own plan and corresponding nutrient percentages.  
The values in Step 2 represent the percent of calories from each nutrient.  Diet & Exercise Assistant tracks 
the three nutrients that contribute to total calories of a food item: carbohydrates, protein, and fat.   

In Step 3 you can keep the automatically assigned nutrient targets or you can enter you own.  Refer to the 
Nutrient Targets chapter for more information on how nutrient targets are calculated and used. 

You can configure Diet & Exercise Assistant to work in combination with any of the popular diet programs 
today: Atkins, South Beach, Shape Up, Zone, etc.  For example, to set up Diet & Exercise Assistant to track 
an Atkins diet, you should select the low carbohydrate diet.  You should turn off automatic calculation of 
nutrient targets and manually specify the grams of carbohydrates you are allowed to have depending on the 
phase of your Atkins diet. 
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Chapter 9 Using the Logbook 
The logbook screen is where you will find a quick summary of your information. 

Daily Steps 
Each day you should perform the following steps: 

1. Input your weight. 
2. Configure your BMR calculation based on your activity level, excluding exercise.  For example, on 

weekends you may not be working and therefore may use the weekend primarily for rest.  If this is the 
case, lower your BMR selection for better calorie estimation. 

3. Log the foods you eat. 
4. Log the exercises and activities you perform each day. 
5. Monitor your total calories and nutrient totals for the day against your goals by using the histogram 

chart. 
6. Input notes in the journal. 
7. Log your water intake using the water counter. 
8. If you have a blood pressure device, input your blood pressure. 
9. Periodically take body measurements and monitor your body shape improvements as you achieve your 

weight loss goals. 

 
Chapter 10 Weighing In 

Each day Diet & Exercise Assistant provides a default weight for you.  The default is based on your recorded 
weight for the previous day(s).  If you advance the Logbook into the future you will create default daily 
weight values.  You may wish to delete the future weight values for better weight chart viewing. 

Since most calorie calculations use weight, you should weigh in periodically to ensure accuracy.  Many 
experts believe that weighing every day can lead to behaviors that are not supportive of weight loss.  You 
should seek a balance that is right for you. 

When you weigh in, it is better to weigh in at the same time each day, preferably in the morning immediately 
after you wake up.  To input a weight, tap the scale icon in the Logbook. 

The calories you burn per day (BMR) are automatically calculated from your personal information and daily 
weight. 
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Using the Daily Weight Chart 
Diet & Exercise Assistant has two weight charts, a daily chart and a historic weight chart.  The daily weight 
chart plots your current weight against what is considered underweight, normal, overweight, or obese.  This 
chart is excellent for setting weight loss goals.  The historic weight chart graphs weight over time. 

Daily Weight Chart Key 
Un: Underweight 
No: Normal weight for your height and gender 
Ov: Overweight 
Ob: Obese 
 
        Target weight 
        Current weight 
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Using the Historic Weight Chart 
The historic weight chart graphs weight values for a selected week or month.  You can select the chart 
resolution by using the drop-down list.  You also have the option of charting weight as a series of points or 
as a line. 

 

 
 

 

Using the Long Range Historic Weight Chart 
Use the Long Range weight chart to plot weight values for 5 years worth of data.  The chart will plot weight 
values beginning from the date selected and going back n days, where n is the number of previous days to 
display. 

The dashed lines represent your starting and goal weights. 
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Chapter 11 Basal Metabolic Rate (BMR) 
Basal Metabolic Rate (BMR) is a mathematical equation to approximate your daily caloric requirement to 
maintain your current weight.  Basal metabolism is affected by many factors: body composition, gender, age, 
height, stress, smoking, caffeine, etc. 

The most effective strategy for increasing basal metabolism is to decrease body fat and increase lean body 
mass.  A healthy diet and daily exercise will positively change your body composition and increase BMR. 

 Gender:  Males will typically have a higher resting BMR than females. 
 Age:  As you get older, lean body mass typically decreases, thus lowering BMR. 
 Height:  Taller, thinner people typically have a higher BMR. 
 Stress:  Psychological and physiological stress can raise BMR. 
 Smoking:  Nicotine in cigarettes increases BMR. 
 Caffeine:  A stimulant, caffeine increases energy expenditure, thus increasing BMR. 

Since most people spend a majority of their day at work, Diet & Exercise Assistant allows you to configure 
your work activity level.  If you do not work in an office environment (the default setting), you should select a 
different work activity level.  Do not use this option as a way to compensate for exercising during the day.  
Diet & Exercise Assistant allows you to enter exercise separately. 

If you have a hardware device capable of measuring your metabolic rate, the software can be configured to 
accept any BMR value.  Simply select the “Other” BMR option and enter the value. 
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Chapter 12 Meal Log 
Every time you consume a food item, you should enter it into the Logbook.  Diet & Exercise Assistant comes 
with a very large food database.  You can select from thousands of standard food items or enter your own 
items if they do not exist in the food database.  The nutrient information tracked can be found on any food 
product label.  There are numerous books and web sites that provide food nutrient information free-of-
charge or for a very small fee. 
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Inserting Foods into the Logbook 
Follow these steps to log a food item including all nutrient values: 

1. Select the “Food Log” tab along the bottom. 

2. Browse the food database using the Food tree or use the Find Food option at the top of the Food tree to 
look up the food you consumed.  

3. If a food item is not in the database, you can input a User-Defined food item by right-clicking in the Food 
tree. To insert the food item, drag and drop it from the tree into the Food Log.  Double-clicking the food 
item in the tree edits the food database; this action does not log a food item. 

4. After you drag and drop a food item from the Food tree, a dialog will be displayed.  You can change the 
serving size units from this dialog.  For example, you can change the serving size units from ounces 
(oz) to grams (g).  The software will convert all nutrient values automatically as you change the units 
and serving size. 

5. Use the Serving Size field to edit portion size.  For example, if you drank 2 Bud Lite beers, instead of 
logging two 12 oz beers, you can change the serving size to 24 oz.  The option is yours; select the 
option that is convenient for you.  A serving size of 1.00 item represents one entity of that particular food 
item.  For example, 1 item is a generic way of saying 1 egg, 1 slice of bacon, or 1 piece of pie.  
Conversion from items to either volume or weight unit is not possible. 

6. Serving size is completely configurable; you should rarely need to change the nutrient values by hand.  
However, this feature is supported, so you can freely change any nutrient values as you wish.  Unless 
you are editing a food item in the database, any change to the nutrients when inserting a food item will 
not change the database. 

To delete, edit, cut, copy, or paste one or more food items, highlight the food item(s) by left-clicking with 
the mouse and select the toolbar button or menu option.  Cut, Copy, and Paste functions are available 
for one or more items in the desktop version.  If you do not like the default food group for specific food 
items, you can cut and paste the item in another food group. 
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Creating a Recipe 
Follow these steps to create a Recipe: 

1. From the Meal Logbook screen, enter all of the individual food items that make up your recipe.  Log all 
individual food items under the same meal type for example Breakfast.   

2. Tap the Breakfast title row to highlight it.  Then tap the Create Recipe button on the main toolbar.  A 
Create Recipe dialog is displayed. 

3. Enter the name of your recipe and change the serving size if necessary. 

4. The default food Group for new Recipes is the Favorites group.  The Favorites group is always located 
at the top of the food database.  Customizing the food database by adding your common food items to 
the Favorites group will dramatically speed up daily food logging. 

5. The nutrient totals for the new recipe is calculated for you.  Create the new recipe by tapping the OK 
button.   

 
 

Favorites Group 
The Favorites group is always located at the top of the food database.  You can not delete or rename the Favorites 
group.  However, you can customize the Favorites group by adding your own Categories, Food Items, and Recipes.  
Customizing the food database by adding your common food items to the Favorites group will dramatically speed up 
daily food logging.  
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Chapter 13 Exercise Log 
Every time you exercise, you should log your activity into the Exercise Log.  Diet & Exercise Assistant 
comes with a large exercise database.  Simply select the exercise that applies to you, enter the minutes you 
spend exercising, and the calories you burn are calculated automatically for you. 

You can enter your own exercise by selecting the User Defined Exercise option from the exercise drop-down 
list.  You will need to know the calories you burn for a user-defined exercise. 

Inserting Exercises into the Logbook 
Follow these steps to log an exercise: 

1. From the Main Logbook screen, tap the Exercise button.  The Exercise Log screen is now displayed. 

2. Use the buttons or menu items along the bottom of the screen to Insert, Delete, Edit, Cut, Copy, or 
Paste an exercise item.  To log a new exercise, select the Insert option. 

3. Select the exercise. 

4. Select the intensity, if applicable. 

5. Input the minutes spent exercising. 

6. Tap the Calorie Calculator icon. 

7. Log the exercise item by selecting the OK button. 

 

To Delete, Edit, Cut, Copy, or Paste an exercise item, highlight the exercise item row and tap the 
corresponding button. 
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Chapter 14 Food Budget 
Food Budget represents the amount of calories you can eat per day and still meet your weight loss goals.  
The following formula represents the calculation of your daily food budget: 

Food Budget = BMR + Exercise – Goal 

• BMR is the amount of calories your body expends per day while at work and when resting. 

• Exercise is the amount of additional calories your body expends per day while exercising. 

• Goal is the number of calories you must eliminate from your diet in order to reach your weight loss 
target. 

Since weight is part of the BMR equation, your daily BMR will fluctuate slightly as you lose weight.  Your 
food budget is calculated each day based on the equation above.  As described in the next section, nutrient 
targets are calculated each day based on your daily food budget.  Remember that regular exercise will 
increase your food budget, allowing you to eat more per day and still reach your daily goals.   

Sound confusing?  It isn’t if you are armed with Diet & Exercise Assistant.  Diet & Exercise Assistant makes 
all calculations and estimations automatically and provides intuitive summary charts for your reference. All 
you need to do is monitor where you are vs. your targets using the nutrient histogram charts. 
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Chapter 15 Nutrient Targets 
Nutrient targets are calculated from the percentages specified as part of the diet plan you selected in the 
Goals step.  These percentages represent the percent values of calories you will receive from each nutrient.  
Diet & Exercise Assistant tracks the three nutrients that contribute to total calories of a food item: 
carbohydrates, protein, and fat.   

1 gram carbohydrate = 4 calories 
1 gram protein = 4 calories 
1 gram fat = 9 calories 
 
Examples: 

1 Small Package of David Sunflower Seeds (Barbeque) 1 Can Natural Light Beer 
220 cal       110 cal 
Carbohydrates 6.0 grams = 24 calories   Carbohydrates 6.6 grams = 26.4 calories 
Protein  9.0 grams = 36 calories   Protein  0.8 grams = 3.2 calories 
Fat  18.0 grams = 162 calories   Fat  0.0 grams = 0 calories 
 
Note: Do not expect the total calories published by a food manufacturer to exactly match the calories from 
the individual nutrients tracked by Diet & Exercise Assistant.  Various factors, such as manufacturer 
averaging of values, etc., can cause discrepancies between the sum of calories from carbohydrates, protein, 
and fat of a particular food item and the total calories published by a manufacturer.  Expect such values to 
deviate considerably for certain food items, particularly drinks.  (See the example for Natural Light Beer 
above.)  As a consequence, the percentage of calories from each nutrient tracked by Diet & Exercise 
Assistant will not necessarily total 100% of the total caloric content of a food item. This is to be expected and 
does not indicate inaccuracies in the food database. 

The following example illustrates how nutrient targets are calculated based on the nutrient percentages of 
the USDA diet (60% carbohydrates, 10% protein, 30% fat) for a food budget of 2,000 calories per day: 

Calories   = Food Budget  = 2,000 calories 
Carbohydrates (grams)  = (2,000 x 60%) / 4 = 300 grams 
Protein (grams)   = (2,000 x 10%) / 4 = 50 grams 
Total Fat (grams)   = (2,000 x 30%) / 9 = 67 grams 
Saturated Fat (grams)  = Fat (grams) / 3  = 22 grams 
Fiber (grams)   = 25   = 25 grams 

It is recommended that only 1/3 of your fat grams should come from saturated fat.  You should also 
consume at least 25 grams of fiber per day. 
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Histogram Analysis 
Use the nutrient histogram charts to compare nutrient intake to your daily goals.  The chart can be viewed 
on a weekly or monthly basis.  The dashed line is the nutrient target.  The nutrient target for calories is your 
daily food budget.  Do not consume more calories than your food budget allows or you will not achieve your 
weight loss goals. 
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Chapter 16 Daily Journal 
Use the daily journal to record any notes you wish.  For example, you can use it to record your feelings and 
emotions as you follow your program: How do you feel on the days when you experience a minor slip?  
What makes you feel this way?  How do you respond? How can you respond more effectively in the future?  

Eating for reasons other than physiological hunger, i.e., emotional eating can cause weight gain and is often 
a symptom of some deeper issue that needs to be addressed.  A better understanding of yourself and your 
emotional eating triggers is vital to successful weight management and your long-term health. 

 
Chapter 17 Blood Pressure 

If you own a blood pressure device, you can use Diet & Exercise Assistant to track your blood pressure.  
Input the systolic/diastolic readings.  Most blood pressure devices have a pulse-per-minute feature.  
Alternatively, you can take your pulse using a simple watch with a second hand.  Input your pulse and the 
date and time you took your blood pressure reading. 

Each person’s pulse is different.  You cannot compare your pulse to another individual’s and just assume 
that the person with the lower pulse rate is in better shape.  However, as you exercise and become fit, you 
will likely notice a decrease in your blood pressure and pulse rate. 

 
 

 
. 
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Chapter 18 Percent Body Fat 
Once you input body measurements, Diet & Exercise Assistant can estimate your percent body fat.  Body fat 
estimation from circumference body measurements is an extremely inaccurate but easy way to obtain a 
body fat estimation without seeking professional help. 

Fat is one of the basic components that make up the structure of your body.  The other components include 
muscle, water, bone, and your organs.  All are necessary for normal, healthy functioning.  Body fat can be 
divided into two categories: essential fat and storage fat.   

As its name implies, essential fat is necessary for normal, healthy functioning.  It is stored in small amounts 
in your bone marrow, organs, central nervous system, and muscles.  In men, essential fat is approximately 3 
percent of body weight.  Women, however, have a higher percentage of essential fat - about 12 percent.  

Storage fat is the other type of body fat.  This is the fat you accumulate beneath your skin, in certain specific 
areas inside your body, and in your muscles.  It also includes the deep fat that protects your internal organs 
from injury.  Men and women have similar amounts of storage fat. 

It is desirable to have some storage fat due to the protective role it plays in your body.  However, most 
storage fat is considered to be "expendable."  Many people have too much storage fat, while some have too 
little. Too much or too little storage fat is unhealthy.   

Healthy Ranges 

Female 

Age 18 - 39   Body Fat:  21 - 32% 
Age 40 - 59   Body Fat:  23 - 33% 
Age 60 - 79   Body Fat:  24 - 35% 

Male 

Age 18 - 39   Body Fat:    8 - 19%   
Age 40 - 59   Body Fat:  11 - 21%   
Age 60 - 79   Body Fat:  13 - 24%  

Too much body fat increases the risk of many diseases, including type-2 diabetes, high blood pressure, 
stroke, heart disease, and certain cancers.  Excess body fat stored around the abdomen increases the risk 
of developing these conditions even further. 
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Chapter 19 Water Intake 
Use the water counter to track water intake.  You specify the counter units according to how you wish to 
track your intake: by the cup, glass, bottle, oz, etc. 

Here is a quick list of the benefits of drinking water: 

• Your metabolism functions better when you’re fully hydrated. 

• Your digestion is improved when you drink enough water. 

• Water fills you up and helps you to eat less. 

• Your exercise is much more effective when you are fully hydrated. 
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Chapter 20 Editing the Food Database 
The desktop application is designed for fast and easy food database editing.  Along the left side of the 
application is the food database tree.  Use the right-mouse menu in the food database tree view to Insert, 
Edit, or Delete food groups, categories and food items.   

Food Database Structure 
The food database structure is based on groups, categories, and food items.  The structure has top-level 
food groups.  You can add, delete or rename any food group.  Food groups contain categories of food items.  
You can add, delete or rename any category you wish.   

Tip:  Placing an asterisk (*) in front of any name will sort the item to the top of the list.  For example, under 
each food group, you can create a category called “*My Foods” and put your food items in this category.  
Customizing the food database based on your eating habits will greatly reduce the time you spend logging 
the foods you eat. 

Use the right-mouse menu in the food database tree to insert, delete, or rename any group, category, or 
food item in the food database. 

Editing Groups 
Follow these steps to add a new group: 

1. Right-click on any top level group and select the menu item “Insert->Group”. 

2. Input the name of the group.  If you wish, place an asterisk (*) in front of the name to sort the group to 
the top of the food group. 

 

 

Follow these steps to delete or rename a group: 

1. Right-click on the group you wish to rename or delete. 

2. Select the appropriate menu item to rename or delete the group. 
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Editing Categories 
Follow these steps to add a new category: 

1. Select the food group in the food database tree where the new category is to be inserted. 

2. Right-click and select the menu item “Insert->Category”. 

3. Input the name of the category.  If you wish, put an asterisk (*) in front of the name to sort the category 
to the top of the food group. 

 

 
 

Follow these steps to delete or rename a category: 

1. Right-click on category you wish to rename or delete. 

2. Select the appropriate menu item to rename or delete the category. 
 

Editing Foods 
Follow these steps to add a new food item: 

1. Select the category where the new food item is to be inserted. 

2. Right-click and select the menu item “Insert->Food Item”. 

3. Input the name of the food item. 

4. Input the serving size and units. 

5. Input the nutrient information. 

6. Select the OK button. 
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Follow these steps to delete or edit a food item: 

1. Right-click on food item you wish to edit or delete. 

2. Select the appropriate menu item to edit or delete the food item. 

Using the Desktop Food Database Tree 
On the desktop, you edit the food database through the Food tree.  The new food database tree offers the 
following features and enhancements: 

1. Place your cursor over a food item, and a tool tip displays the serving size and nutrient information. 

2. Re-arrange the food database by dragging and dropping food items from one category to another. 

3. Log food items by dragging and dropping them from the Food Tree view into the Food Log. 

4. Cut, copy, and paste food items or entire categories of foods from one food group to another. 

5. Rename the food item or category just like you rename a file using the Windows Explorer. 

6. You can select a food item or category and easily delete it by using the Delete key. 

7. Use the right-mouse menu to easily insert a food item into the database. 

8. Double-click on a food item in the Food Tree to insert the food into the daily Food Log. 
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Chapter 21 Import and Export 
Diet & Exercise Assistant supports exporting of your user data to a comma separated values (.csv) file.  This 
file can then be opened in Excel for further charting and data analysis.  

Exporting User Data 
Follow these steps to export user data: 

1. Left-click the File menu.   

2. Select the menu item Export->User Data to export your user data to comma separated values file.   

3. The following dialog is displayed.  Use the Browse button to specify a filename and path. 

4. Select the OK button. 
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Exporting Food Data 
Diet & Exercise Assistant supports exporting of food database data to comma separated values (.csv) file.  
You can export the entire food database, an entire food group, or a single category.  Exporting food data 
allows you to: 

1. Share food database data between family and friends. 

2. Backup your food database. 
 
Follow these steps to export Food data: 
 
1. Left-click the File menu. 

2. Select the menu item Export->Food Data to export your Food data to comma separated values file. 

3. The following dialog is displayed.  Select which food group and category to export. 

4. Use the Browse button to specify a filename and path. 

5. Select the OK button. 
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Importing Food Data 
Diet & Exercise Assistant supports importing food database data from a comma separated values file.  Only 
files exported from within Diet & Exercise Assistant can be imported. 

Follow these steps to import Food data from a file: 
 
1. Left-click the File menu. 

2. Select the menu item Import->Food Data->From File to import from a comma separated values file. 

3. The following dialog is displayed.  Select an import option. 

4. Use the Browse button to specify a filename and path. 

5. Select the OK button. 
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Chapter 22 Desktop Menu and Toolbar Items 
The menu system and toolbar offer similar functions.  The following is a list of features available from the 
menu or Toolbar. 

[New User] Creates a new user 

[Open User] Opens an existing user 

[Save User] Saves the daily data and food database changes 

[Print]  Prints the daily data 

[Print Preview] Previews the print job 

[Cut]  Cuts a selection of food or exercise items 

[Copy]  Copies a selection of food or exercise items 

[Paste]  Pastes the clipboard contents 

[Create Recipe] Creates a recipe from a meal of logged items 

[Sort]  Sorts the visible food list by meal type or alphabetically 

[Nutrient Toggle] Toggles the nutrients 

[First Day] Jumps to the first day with data 

[Previous Day] Jumps to the previous day 

[Next Day] Jumps to the next day 

[Last Day] Jumps to the last day with data 

[Install]  Installs handheld software (Bundle Only) 
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